Congratulations on your new Chevrolet Bolt EV.

It’s an amazing vehicle, and we’re sure you’re eager to get behind the wheel and see what it can do. For a quick introduction to the Bolt EV, review this quick reference guide. It provides the basic information needed to charge it, start it, and hit the road. Complete details can be found in your Owner Manual.

If you have any questions or would like more information about your Bolt EV, contact a Bolt EV Customer Advisor at 1-877-486-5846.

www.chevrolet.com/boltev
Instrument Panel

- Regen on Demand Paddle (behind steering wheel)
- Exterior/Interior Lamp Controls
- Cruise Control/Forward Collision Alert/Lane Keep Assist/Heated Steering Wheel Controls
- Turn Signal Lever/IntelliBeam Control
- Instrument Cluster/Driver Information Center
- Windshield Wipers Lever
- Power Mirror Controls/Power Window Controls/Rear Windows Lock
- Audio Favorite Stations Buttons
- Tilt/Telescopic Steering Wheel Lever (on steering column)
- Voice Recognition/Driver Information Center Controls
- Audio Volume Buttons (behind steering wheel)
- Power Button

Symbols

- BRAKE: Brake System
- Safety Belt Reminder
- Passenger Safety Belt Reminder
- Airbag Readiness
- IntelliBeam Lighting
- 12V Charging System
- Vehicle Ahead
- Lane Keep Assist Warning
- Security
- Service Vehicle Soon
- Electric Parking Brake Set
- Cruise Control
- Door Ajar
Refer to your Owner Manual to learn about the information being relayed by the lights, gauges and indicators of the instrument cluster.

See In Brief in your Owner Manual.
Remote Keyless Entry (RKE)
The RKE transmitter (key fob) performs several remote functions and must be in the vehicle to start the Bolt EV.

Keyless Access
With the RKE transmitter within 3 ft. (1 m) of the door, press the button on the driver’s door handle to unlock the door. Press it again within 5 seconds to unlock all doors and the liftgate.

Press the button on a passenger’s door handle to unlock all doors and the liftgate.

When unlocked, press the button on any door handle to lock all doors and the liftgate.

Key Release
Press the side button on the transmitter to remove the key, which can be used to unlock the driver’s door.

Unlock
Press to unlock the driver’s door. Press again to unlock all doors.

Lock
Press to lock all doors.

Panic Alarm
Press and release to locate the vehicle. Press and hold for 3 seconds to sound the panic alarm.

Remote Start
Press the Lock button and then press and hold the button until the turn signal lamps flash to start the vehicle and condition the passenger cabin temperature from outside. The heating or air conditioning system and rear window defogger (if needed) will turn on.

After entering the vehicle, press the brake pedal and then press the POWER button before driving.

Note:
• Press and hold the Remote Start button until the parking lamps turn off to cancel a remote start.
• Only two remote starts are allowed between ignition cycles.
• It’s RECOMMENDED to use this feature when the vehicle is plugged in to allow energy from the wall outlet to assist in getting the cabin to a comfortable temperature and to leave more battery energy for driving.

See Keys, Doors and Windows in your Owner Manual.
Getting Started

POWER Button
The Bolt EV features an electronic push-button start. The \( \text{POWER} \) button flashes when the driver’s door is opened upon entry. Once the vehicle is ON, the button illuminates.

**Note:** The air conditioning compressor, pumps and fan may run at any time — even when the vehicle is OFF — to cool or warm the propulsion battery.

Starting the Vehicle/ON
- With the vehicle in Park or Neutral, press the brake pedal and then press the \( \text{POWER} \) button. A power ON audio cue will sound.

The vehicle will not shift out of Park and a Charge Cord Connected message will display if the vehicle is still plugged in.

When ON, the instrument cluster will display an active battery.

Stopping the Vehicle/OFF
- Shift to Park and then press the \( \text{POWER} \) button. A power OFF audio cue will sound.

Pedestrian Safety Signal
The vehicle is equipped with an automatic sound generator. The sound is automatically generated at speeds below 14 mph to indicate the vehicle’s presence to pedestrians.

See [Driving and Operating in your Owner Manual](#).

Driver’s Seat and Steering Wheel Adjustment
Before driving, adjust the steering wheel and seat to a comfortable position.
- Pull down the lever (A) to unlock the steering wheel and adjust its position.
- Lift the handle (B) under the right-front side of the seat to slide the seat forward or rearward.
- Ratchet the side lever (C) up or down to raise or lower the seat.
- Lift the rear lever (D) to adjust the seatback.

See [Seats and Restraints in your Owner Manual](#).
Electronic Precision Shift

The electronic drive unit shift lever always starts in a center position, represented by a dot on the shift pattern displayed on top of the shift lever. The selected gear position illuminates in red. After shifting, the shift lever returns to the center position.

**Park** – Press the button on top of the lever (A) to shift into Park. The vehicle will not shift out of Park unless the ignition is on, the brake pedal is applied, and the button on the side of the lever (B) is pressed.

**Reverse** – Press the button on the side of the lever (B) and move the lever forward and then left to shift into Reverse.

**Neutral** – Move and hold the lever forward for ½ second to shift into Neutral.

*Note:* The transmission will not stay in Neutral for an extended period. It will automatically shift into Park.

**Drive** – Move the lever rearward to shift into Drive.

**One-Pedal Driving** – With the transmission in Drive, pull the lever rearward to the L (Low) position to enable “one-pedal” driving. When the accelerator pedal is not applied, regenerative braking is active to help slow the vehicle. Use the brake pedal for additional braking or panic stops. Pull the lever rearward again to return to Drive.

**Automated Car Wash Mode**

To place the transmission in Neutral with the vehicle running:

1. While pressing the brake pedal, open the driver’s door and then shift to Neutral.
2. The indicator should show N. If it does not, select Neutral again.
3. Upon returning to the vehicle, shift into Park.

**Electric Parking Brake**

- To apply the parking brake, pull up the (P) Parking Brake switch by the shift lever.
- To release the parking brake, turn on the vehicle, press the brake pedal, and then press the (P) switch.

*See Driving and Operating in your Owner Manual.*
The instrument cluster features an LCD screen that can be configured in 3 different themes.

**Classic** – Displays basic information on speed, range and other operations along with an efficiency bar that glows green to yellow based on driving efficiency.

**Modern** – Displays basic information plus power usage and an efficiency ball that moves up and down based on driving efficiency.

**Enhanced** – Displays basic information plus a maximum and minimum range indicator, power usage and an efficiency ring that glows green to yellow based on driving efficiency.

**Cluster Display Zones**

- Press the left or right arrow on the Driver Information Center (DIC) controls, located on the right side of the steering wheel, to move between the different display zones.
- Press the up or down arrow on the DIC controls to scroll through the display menus.
- Press ✔️ on the DIC controls to select a highlighted item.

**Cluster Layouts**

1. Use the DIC controls to select the Layout menu in the left display zone on the cluster.
2. Press ✔️ to display the Layout menu.
3. Scroll to highlight one of the cluster layouts; press ✔️.
4. Press ⬅️ to exit the menu.

**Cluster Help**

To view helpful information about the features of the instrument cluster, with the vehicle in Park, use the DIC controls to select Help from the Options menu.

*See Instruments and Controls in your Owner Manual.*
Efficiency

Electric Range
Electric range is affected by colder outside temperatures. During colder months, the energy needed to warm the vehicle’s cabin and propulsion battery can cause the vehicle’s electric range to decline. See Driving for Better Energy Efficiency in the Driving and Operating section in your Owner Manual.

Driving Style
Your driving style plays a large role in the efficiency of the vehicle. Avoid rapid acceleration or deceleration to help maximize energy efficiency and range. Electric range is maximized at 50 mph and below; higher speeds use more energy and significantly reduce electric range.

Efficiency Gauges
► Use the 5-way control to select an instrument cluster layout that displays the green efficiency bar, ball or ring indicator.

While driving, try to keep the bar or ring green, or the ball in the center of the gauge, depending on the cluster theme selected. The bar or ring will turn yellow or the ball will move up or down during inefficient acceleration or aggressive braking.

Sport Mode
► Press the MODE button on the center of the instrument panel to select the Normal or Sport driving mode.

Normal (Default)
Use in normal driving conditions for efficient operation. This mode is active each time the vehicle is started.

Sport
Use when more performance is needed. This mode increases throttle response. The Sport indicator will illuminate on the instrument cluster.

Regen on Demand™
Regen on Demand temporarily regenerates energy from the vehicle’s momentum and stores it in the high voltage propulsion battery for later use.

► To activate Regen on Demand, pull and hold the left paddle on the back of the steering wheel without pressing the brake pedal or accelerator pedal.

While pulling the paddle, the vehicle will begin to decelerate using regenerative braking. Regen on Demand is deactivated once the paddle is released or the accelerator pedal is pressed.

See Driving and Operating in your Owner Manual.
Efficiency

Climate Settings
Optimal efficiency is achieved with the climate system off (the climate ON indicator is off on the touchscreen). If using the climate system, the most efficient operation is in the following order:

**Fan Only** – electric cabin heating/cooling is off (Heat & A/C button indicator is off)

**Heat & A/C** – provides active cabin heating/cooling, but uses more energy. Touch the screen button to turn the air conditioning and heater on when the fan is on.

Use the heated seats and heated steering wheel (if equipped) to reduce the demand on the cabin heating system. Heating the seats and steering wheel uses less energy than heating the vehicle interior.

*See Climate Controls in your Owner Manual.*

Information Displays

- Press the Energy button on the touchscreen and then touch the Flow, Charging, Information, or Energy Settings icon to display the desired energy information.

Flow
The Power Flow screen indicates the current system operating condition, showing the power flow between the high voltage propulsion battery and electric drive unit.

Charging
The Charging screens show the Charge Mode and Charge Limit status. The vehicle has three programmable charge modes:

- Immediately upon plug-in
- Delayed based on departure time
- Delayed based on electric rates and departure time

Touch each screen button to change the settings. See Charging (page 12).

Information
The Information screens show the Energy Detail since the last time the vehicle was fully recharged. The Energy Usage Score provides an estimate of the factors that influence energy usage since the last full charge. The Consumption History shows the average energy efficiency over the last 50 miles.

Energy Settings
The Energy Settings include feedback and alerts that can be set to your preference.

*See Instruments and Controls in your Owner Manual.*
Settings and Controls

Refer to your Owner Manual for important safety information about using the infotainment system while driving.

Vehicle Personalization
A number of vehicle features can be customized using the Settings menus on the touchscreen.
1. Touch Settings on the Home screen.
2. Touch the desired menu item.
3. Touch the desired feature and setting.
4. Touch the Return icon to exit each menu.

Infotainment
The Infotainment system features radio, auxiliary device input, voice recognition and Bluetooth® phone and audio functions, and available navigation.
► Connect an auxiliary device to the input jack or USB port, located in the compartment behind the shift lever.
► To pair a Bluetooth phone, use the touchscreen to select Settings > Devices > Add Device. Follow the pairing instructions.

For more information, visit my.chevrolet.com/learn.

Apple CarPlay™ and Android Auto™
Apple CarPlay or Android Auto capability may be available through a compatible smartphone. If available, a Projection icon will appear on the Home page icon screen of the infotainment display.
1. No app is required for Apple CarPlay. Download the Android Auto app to your phone from the Google Play Store.
2. Connect your Apple iPhone or Android phone by plugging the compatible phone USB cable into a USB data port. Use your device’s factory-provided USB cable. Aftermarket cables may not work.
3. The Projection icon will change to Apple CarPlay or Android Auto, depending on the phone. Apple CarPlay or Android Auto may launch automatically upon USB connection. If not, touch the Apple CarPlay or Android Auto icon on the home page.

For more information, visit my.chevrolet.com/learn.

OnStar with 4G LTE and Wi-Fi®
With OnStar 4G LTE and Wi-Fi®, up to seven devices (smartphones, tablets and laptops) can be connected to high-speed internet through the vehicle’s built-in Wi-Fi hotspot.
► To retrieve the SSID and password for the hotspot, press the OnStar Voice Command button on the overhead console, wait for the prompt, and then say “Wi-Fi settings.” The information will be displayed on the screen.

For assistance, press the blue OnStar button or call 1-888-4-ONSTAR (1-888-466-7827).

See Infotainment and Instruments and Controls in your Owner Manual.
Settings and Controls

Siri® Eyes Free
Siri Eyes Free allows hands-free access to the voice recognition commands on a compatible iPhone®. The cell phone must be paired to the in-vehicle Bluetooth system. For more information, visit my.chevrolet.com/learn.

- To activate Siri Eyes Free, press and hold the Push to Talk button on the steering wheel until Siri speaks.

Wireless Charging for Mobile Devices
The Wireless Charging system, if available, is located in the center console. A compatible wireless charging adapter (not supplied) for the device may be needed. For more information and to check mobile device compatibility, visit my.chevrolet.com/learn.

1. The vehicle must be ON.
2. Remove all objects from the charging slot.
3. Place the mobile device upright, facing the driver, in the charging slot.
4. Move the device slowly until the battery charging symbol displays on the touchscreen, indicating the device is charging.

See Infotainment and Instruments and Controls in your Owner Manual.

Climate Controls

The indicators on the climate controls show which feature is active: Defrost/Defog, Air Delivery Mode, Max Defrost, AUTO (Automatic Operation), and Rear Window Defogger.

Climate temperature and changes in the climate system functions are displayed on the touchscreen.

- Press the AUTO button to have the system operate automatically based on the temperature setting.

See Climate Controls in your Owner Manual.

Optional equipment
Battery
The Bolt EV is powered by a lithium-ion high voltage battery pack, which holds its charge efficiently and has no memory effect (so it doesn’t have to be run down completely before recharging). Keep the vehicle plugged in, even when fully charged, to keep the battery temperature ready for the next drive.

Charging Time
Charging rates and times vary depending on outside temperature and remaining charge.
► When using a 120-volt electrical outlet, it will charge at a rate of 4 EV miles per hour with the 12-amp setting (approximately 50 hours total to charge the vehicle).
► When using a 240-volt charging station, it will charge at a rate of 12 EV miles per hour at a 16-amp level (approximately 19 hours total), and at a rate of 25 EV miles per hour at a 32-amp level (approximately 9½ hours total to charge the vehicle).
► Using a public DC Fast Charging station with the available Fast Charge port, it will charge to achieve 90 EV miles in 30 minutes at an 80kW power level from a depleted battery.

Programmable Charging
There are 3 programmable charging modes: Immediately upon plug-in; delayed based on Departure time; and delayed based on Electric Rate and Departure Time.
► Touch the Energy icon on the touchscreen and then touch the Charging icon to view the current Charge Mode and Charge Limit.
► Touch the Charge Limit toggle button to select a different charge level.
► Touch the desired Charge Mode box to select a different charge mode.

Charging Status
The Charging Status indicators are located on the instrument panel near the windshield and on the illuminated charge port (if available).

Single tone and flashing indicator – Vehicle is plugged in; battery is charging. Flashes indicate current percentage of battery charge.
1 flash: 0–25% charged
2 flashes: 25–50% charged
3 flashes: 50–75% charged
4 flashes: 75–99% charged
Solid light: 100% charged

Slow (long pulse) flashing green indicator with double tone – Vehicle is plugged in; battery charging is delayed

Solid green indicator – Vehicle is plugged in; battery is fully charged
Solid yellow indicator – Vehicle is plugged in; not charging
No light – Vehicle is not plugged in OR there is an issue with the charger or outlet
No light and repetitive tones – Issue with the charge cord connection

See Driving and Operating in your Owner Manual.
Charging

Start Charging
The provided 120-volt portable charge cord is located under the storage floor in the cargo area and can be used to charge the vehicle when a 240V charging station is not available.

1. With the vehicle parked, turn off the vehicle and select the Charging button at the bottom of the Energy Summary screen.

2. Review the selected Charge Mode and Charge Limit. Select the Charge Limit toggle button if an increased charging limit is desired. Use the 8-amp charge limit until a qualified electrician inspects your home’s electrical circuit capacity, or if the electrical circuit or outlet capacity is not known.

   **Note:** The charge level selection returns to the 8-amp setting each time the vehicle is driven.

3. Plug the charge cord into an electrical outlet. DO NOT PLUG INTO AN EXTENSION CORD. Charge cord indicators should be green. Where possible, secure the charge cord to the wall.

4. Press and release the rear edge of the charge port door, located just in front of the driver’s door, to open it. Plug the charge cord into the charge port.

5. The Charge Status indicator on top of the instrument panel will illuminate green and a tone will sound when properly connected.

6. Periodically check the electrical outlet/plug while charging. Discontinue use if the electrical outlet/plug is hot and have the electrical outlet serviced by a qualified electrician.

If the vehicle is locked with the RKE transmitter, the charge cord theft alert is armed automatically after 30 seconds.

   **Note:** When the theft alert is armed, the alarm will sound when the plug is disconnected from the vehicle. To change charge cord theft alert options, go to Energy in the Vehicle Settings menu.

   ➤ To temporarily override a delayed charge event, remove and reconnect the charge cord to the vehicle within 5 seconds. It will begin charging immediately.

   See Driving and Operating in your Owner Manual.
Charging

End Charging
1. Unlock the vehicle with the RKE transmitter to disarm the charge cord theft alert.
2. Unplug the charge cord from the vehicle by squeezing the top latch button.
3. Unplug the charge cord from the electrical outlet.
4. Stow the charge cord.

Location-Based Charging
Charging settings can be saved for your home location and the vehicle will automatically revert to these settings when parked at its “home” location.
1. From the Energy Home screen, select Energy Settings > Location-Based Charging.
2. Select On.
3. Select Update Home Location. Add the required information to set the current vehicle location as the home location.
When away from the home location, the Bolt EV will charge immediately when plugged in.

Home Charging Station
Charging equipment with at least a 240-volt/32-amp rating will provide the fastest charging time to recharge the propulsion battery.
For more information about an available 240-volt home charging station, contact your Chevrolet dealer.
DC Charging (if equipped)

DC charging stations are typically found in public locations.

Charging Time
Using a DC charging station, it will take approximately 30 minutes to recharge a depleted battery to 90 miles of EV range. Charge times will vary with outside temperature. Charging will continue to 100%, but at a slower rate. At 100% state of charge, the vehicle may continue to draw power to condition the battery if needed. Once battery conditioning is complete, the vehicle will stop the charge session.

Start DC Charging
1. With the vehicle parked and turned off, push and release the rear edge of the charge port door, located just in front of the driver’s door, to open the door.
2. Unlatch and lower the DC charging dust cover on the charge port.
3. Plug the charge cord into the vehicle’s charge port.
4. Follow the steps on the charging station to start charging. The electric parking brake will automatically apply and the DC plug will be locked and cannot be disconnected while charging is active.
5. The Charge Status Indicator on top of the instrument panel will illuminate green and the horn will chirp when properly connected.

Note: To change the horn chirp setting, go to Charging Alerts in the Vehicle Settings menu.
If the vehicle is locked with the RKE transmitter, the charge cord theft alert is armed automatically after 30 seconds.

End DC Charging
1. Unlock the vehicle with the RKE transmitter to disarm the charge cord theft alert.
2. When the vehicle is fully charged, it will stop charging and the plug will be unlocked. To stop charging at any time, use the controls on the charging station or touch the Stop button on the Battery Information screen on the vehicle touchscreen.
3. When the Charge Status Indicator is solid green or off, unplug the charge cord from the vehicle.
4. Close the DC charging dust cover and close the charge port door.
5. Disengage the electric parking brake before driving the vehicle.

See Driving and Operating in your Owner Manual.
Roadside Assistance

1-888-811-1926 TTY Users: 1-888-889-2438

As the owner of a new Chevrolet, you are automatically enrolled in the Chevrolet Roadside Assistance program for 5 years/60,000 miles, whichever occurs first, at no expense to you. Chevrolet’s Roadside Assistance toll-free number is staffed by a team of trained advisors who are available 24 hours a day, 365 days a year, to contact a service provider for light services (jump-starts, flat tire and lock-outs) or make arrangements to tow your vehicle to the nearest Bolt EV Authorized Chevrolet dealer.

Roadside Assistance and OnStar®

If you require roadside service and have a current OnStar subscription, press the OnStar button and the vehicle will send your current GPS location to an OnStar Advisor who will speak to you, assess your problem, contact Roadside Assistance and relay your exact location so you will get the help you need.

myChevrolet Mobile App

The myChevrolet mobile app connects owners with a compatible mobile device to a variety of vehicle information and services, such as a searchable owner manual, OnStar Vehicle Diagnostic information and Roadside Assistance.

The myChevrolet mobile app also enables users to search for charging stations, send remote commands, check the current battery charge level and initiate charging of your Bolt EV.

Download the mobile apps from your compatible mobile device’s app store.

To learn more about OnStar services, press the blue OnStar button, visit onstar.com, call 1-888-4-ONSTAR (1-888-466-7827), or refer to your owner manual.

Chevrolet Owner Center

Get to know your vehicle inside and out with the Chevrolet Owner Center. Check out personalized information, including an online owner manual and helpful how-to videos, track your service history and warranty status, review your current OnStar Vehicle Diagnostics report (active OnStar account required) and more. Create an account today at my.chevrolet.com.

We recommend always using ACDelco or genuine GM service parts.

Certain restrictions, precautions and safety procedures apply to your vehicle. Please read your Owner Manual for complete instructions. All information contained herein is based on the latest information available at the time of printing and is subject to change without notice. Copyright 2016 General Motors. All rights reserved.